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Sources – Creating and Using 

 

The following are three ways of creating a source.  Choose the one that is appropriate for your 

situation. 

 

Create a New Source While Editing an Individual 

1. In PAF, double click an individual to open the Edit Individual window.  

2. Double click the small “s” or “*s” (source) at the right of the events such as birth, death, 

marriage, or the Individual Sources button.   If a source is already attached for this event, 

click New. 

3. Select a source from the list and go to step 4 or create a new source by clicking New at 

the bottom of the Select Source window.    

a. Type the source information | click the Repository button, then Select or Add a 

repository. 

b. Click OK to save the new source. 

4. With the source highlighted click the Select button at the bottom of the screen. 

5. See the Citation topic below. 

 

Create a New Source from the Edit Menu  

1. Open the Edit menu | select Source List. 

2. In the Edit Source List windows  

a. To create a new source click New at the bottom of the Edit Source List window.   

b. Type the source information | click the Repository button, then Select or Add a 

repository. 

3. Finish typing the source information  

4. Click OK | click the Close button. 

 

Create a New Source by Copying an Old Source 

1. While in the Edit Source List ( Edit menu | Source List) 

2. Select the source to be copied | click the Copy button at the bottom of the Edit Source 

List window  

3. Make the changes to the source, such as year, title, etc. 

a. Example:  Copy the “Census:  US Federal 1900”.  Change the title to “Census:  

US Federal 1910”.  Note:  This method can be used to enter all the censuses.  

4. Click OK  
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Citation 

Once created, the new source is available to cite for any event or individual in the PAF file.  

When a source is attached to an event or individual, a citation is created.  The specific 

information for the event or individual should be added and then click OK. 

Note:  Once the event has a source attached the “S” is changed to a “*S”.   

See the following steps to memorize a citation and use it multiple times. 

 

Memorize a Citation to Use for Another Event 

1. Double click the individual with the desired citation | double click the small “*s” at the 

right of the event. 

2. Select the appropriate citation | click the Memorize Citation button – The two sheets of paper 

icon at the bottom right corner of the window | Click OK to close the Source window. 

3. Click Save to close the Edit Individual screen. 

4. Select the individual to which the memorized citation is to be attached. 

5. Two situations may occur, “s” or “*s”: 

a. Situation #1:  Double click the small “s” at the right of the event | click Use Memorize 

Citation | OK 

b. Situation #2:  Double click the small “*s” | click Paste Memorized Citation button – 

The clipboard with one sheet of paper icon at the bottom right corner of the window | 

change the appropriate citation information | click OK. 
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Setting up a Flash Drive 

and 

Backing up the Folders 
 

Flash Drive – Diagram of folders 
 

PAF files (.paf) are stored on and opened from the flash drive.  The following method 

stores the .paf file and the Image folder inside another folder named Family History 

File and Images.  The Image folder contains images such as census, certificates, 

photos, etc. that can be attached to the individuals in the .paf file.  Set up the flash 

drive in this manner:   
 

  

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

1. On the flash drive create the 

folder – Family History File 

and Images 
 

2. Open that folder and inside it 

create another folder – Images 
 

3. Move the PAF (.paf) file to the 

Family History File and 

Images folder 
 

4. Move the images to the Images 

folder.  

Family  

History  

File and  

Images 

Images

      
.paf file(s) 

 

Name the images with the name of the person to whom they pertain and the type 

of image.  
 

Examples:  

1. A picture of John Albert Smith as a baby: Smith, John Albert – Picture 

1889 

2. A picture of John Albert Smith as a young man: Smith, John Albert – 

Picture 1911 

3. A birth certificate of John Albert Smith: Smith, John Albert – Birth 

certificate 

4. An image of the 1900 census containing information about John Albert 

Smith: Smith, John Albert – Census US Federal 1900 



 

FHC 001 (25 March 2009) 4 - 9 BYU-Idaho Family History Center 

Backing up on the Home computer 
 

On your home computer create a folder in documents named PAF Backups. 
 

 

 

 

 

 

 

 

 

 

 

 

 

Backing up Images and PAF file 
 

 

 

 

 

 

 

 
 

Note: If you lose or corrupt your flash drive, therefore your PAF file, obtain a new flash drive and copy the 

latest Family History File and Images folder to the new flash drive.  If a newer backup exists in PAF 

Backups, start PAF | select the File menu | click Restore and restore the newest backup.  If the restore did not 

replace the PAF file on the flash drive, select the File menu | click Save As and replace the PAF file on the 

flash drive. 

 

 
 

 

 

 

 

 

 

 

 

Note:  Some old programs, like TempleReady, may not work with the PAF file in a folder; therefore, when 

using these programs, copy the PAF file to the desktop of the computer and work with that copy on the 

desktop.  When you have completed updating the PAF file, copy the file from the desktop back to the flash 

drive and replace the former PAF file with the updated copy. After it is copied, delete the desktop copy.  If you 

do not know how to do this, ask a Family History Center missionary for assistance. 

Send 

When quitting PAF: 
 

Click the small x  
 

Next click the large X 

 Backup Daily – on home computer to Documents  |  PAF Backups folder 
 

 Backup Once a Week – on home computer to Documents  |  PAF 

Backups and add the date, 25 Mar 2009 poole.zip 
 

 Once or Twice a Month – E-mail yourself and attach your 
dated backup file – 25 Mar 2009 poole.zip 

 

 Once a Month – backup the Family History File and Images folder by 

copying it to Documents on home computer or copying it to a second flash 
drive.  Then rename it, adding the current date, 1 Nov 08 Family History File 
and Images.  As they accumulate, delete the older copies.  The folder could 
also be burned to a CD. 
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Examples of Sources and Citations 
 

In PAF: click Edit menu | Sources List 
 

Source: Source Title:  Descriptive title of the source. 

Author:  Who is responsible for creating the source; author, compiler or editor?  If 

unpublished the individual or institution who created the record. 

Publication Information:  In what form (book, film, fiche, CD, Internet); If published, 

who printed or distributed the source. 

Repository: (Name, address, phone #) The central place where this source data is stored. 

Call Number:  The source call number if obtained from a library or archive. The 

Internet address (URL) if obtained from the Internet.  

Actual Text:  The actual text typed here will appear every time the source is used, 

therefore, if used; it should be actual text about the source in general.  Specific actual 

text is put in the Citation Detail rather than the source.  

Comments:  The comments typed here will appear every time the source is used.  

Therefore, type only comments or explanation about the source.  Specific comments 

and information are put in the Citation Detail rather that the source. 
 

Citation: Record the specific film, page, or volume from the source where the particular 

information for the specific person(s) cited was found.  Include the date and the place 

where the record was made and any other information from the source that you would 

like to preserve in the file.  
 

This list that follows is not meant to be comprehensive.  It contains some broad examples along 

with a few alternate examples.  The important thing to remember is to be consistent in how sources 

are entered, and make them as complete and clear as possible so another person is able to follow in 

your footsteps and find the same information.  
 

 

Source:      Title: Birth Records – Idaho 

       Author: State of Idaho 

       Publication Information:  Certificate 

       Repository:  Idaho Department of Health and Welfare 

     450 W. State St., 1st Floor 

      Vital Statistics Unit 

      P.O. Box 83720 

      Boise, Idaho  83720-0036  

 

Citation:    #37692  -  11 Aug 1906 - Certificate in possession of Jennifer McVey. 
 

 

Source: Title: Book – Pioneers and Prominent Men of Utah 

 Author: Esshom, Frank 

 Publication Information: Utah Pioneers Book, Salt Lake City, Utah, 1913 

 Call Number:  979.2 D3 

 Repository: Family History Library 

 35 North West Temple 

   Salt Lake City, Utah 84150-3400 

 

Citation: Page 211 
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Source: Title: Cemetery Records:  Find a Grave 

 Author: Contributors 

 Publication Information: Internet Online Index 

 Call Number:  http://www.findagrave.com       

 Repository: http://www.findagrave.com  

  Find a Grave 

  PO Box 522107 

  Salt Lake City, Utah 94152-2107 

 Comments:  Click “Search for a Cemetery” and type the name of the cemetery and/or country 

and state.  OR 

  Click “Search 22 million grave records” 

 

Citation: Grave Location: Victor Cemetery, Victor, Teton, Idaho, USA, Plot: Sec 4 Lane B Lot 11 

   

 

Source:       Title: Census – Canada 1901 

 Author: Canadian Government 

 Publication Information: Online database 

 Repository: Library and Archives Canada 

    395 Wellington Street 

    Ottawa, ON  K1A 0N4   CANADA 

 Comments:   Index and images - automatedgenealogy.com 

 

Citation: Schedule 4 Microfilm T-7391 – McGrath, Alberta 

 

 

Source: Title: Census – England 1851 

 Author: British Government 

 Publication Information: Online Database      

 Repository: Family Records Office  

  1 Myddelton Street 

  London, UK  EC1R 1UW 

  0151 471 4800 (certificate enquiries) 

 Comments:  Index at Ancestry.com, Some images at FindMyPast.com 

 

Citation: Class HO107; Piece 2398; Folio 497; Page 37; GSU roll 87076 - 30 Mar 1851 – Southwick 

Durham England   Robert and Elizabeth Siddoway and daughter Isabella 

 

 

Source: Title: Census – US Federal 1870 

 Author:  United States Census Office   

 Publication Information: Microfilm and Online database   

 Repository: National Archives and Records Administration  

  7
th
 & Pennsylvania Avenue, NW 

  Washington, DC 20408 

 Comments: Index and images - Ancestry.com, Heritagequestonline.com, microfilms - Family 

History Library  

 

Citation: Roll: M432_495; Page: 249; Image: 49 -- 31 Jul 1860 -- Thatcher, Bannock, Idaho.  John and his 

wife Mary along with four children… 

 



 

FHC 001 (25 March 2009) 7 - 9 BYU-Idaho Family History Center 

Source: Title: Church Records – LDS Ward Membership Summary 

 Author: The Church of Jesus Christ of Latter-day Saints 

 Publication Information: Computer printout from ward clerk 

 Repository: The Church of Jesus Christ of Latter-day Saints 

     Membership Department 

  50 East North Temple 

      Salt Lake City, Utah 84150-3400 

 

Citation: December 16, 2005 -- Huntsville Ward, Huntsville, Utah 

 Copy in possession of Sally Jones 

 

 

Source: Title: Death Records – Social Security Death Index 

 Author: US Social Security Administration 

 Publication Information: Online Database   Call Number:   

 Repository: Social Security Administration 

  Baltimore, Maryland or any local office 

 Comments: The index is available at multiple free online sites including FamilySearch.org 

 

Citation: Lists birth date, death month and year, and last residence 

 

 

Source: Title: Family Records – Mary Jane Smith 

 Publication Information:  Unpublished  

 Repository: Mary Jane Smith 

  Toledo, Ohio 43601 

 Comments:  Record contains dates and places recorded from personal knowledge, but include 

original documents, certified and photo copies of original documents. 

 

Citation: Funeral program 
 

 

Source:      Title: Immigration – New York Passenger Lists 

                  Author: New York Port Authority 

 Publication Information:  Microfilm and Online database 

 Repository:  National Archives and Records Administration  

  7
th
 & Pennsylvania Ave., NW 

  Washington, DC 20408 

 Comments:  Indexes available at Ancestry.com, SteveMorse.org, FindmyPast.com, 

CyndisList.com and other sites. 

 

Citation:     Microfilm M237, Roll 191, Line 62, List #367 – Henry Harries and Mary Rees 
 

 

Source: Title: International Genealogical Index 

 Author: The Church of Jesus Christ of Latter-day Saints 

 Publication Information: Online Database  Call Number:  FamilySearch.org 

 Repository: Family History Library 

     35 North West Temple 

      Salt Lake City, Utah 84150-3400 

 

Citation: Search performed 10 March 2006 
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Source: Title: Military Records – World War I Draft Registration 

 Author: Selective Service Administration 

 Publication Information: Online database  Call Number:   

 Repository: National Archives and Records Administration  

  7
th
 & Pennsylvania Ave., NW 

  Washington, DC 20408 

 Comments:  Indexed and images - Ancestry.com 

 

Citation: Vol. 6, Record No 2341 -- June 4, 1918 -- Teton, Fremont, Idaho  

 Accompanied by wife Nellie.  Tall, medium build, blue eyes, brown hair 
 

 

Source:     Title:  Mormon Pioneer Overland Travel, 1847-1868 

                  Author: The Church of Jesus Christ of Latter-day Saints 

       Publication Information:  Online Database             Call Number:  LDS.org 

       Repository:   Church History Library 

      50 East North Temple 

      Salt Lake City, Utah 84150-3400 

 

Citation:  Robert F. Neslen Company departed Florence Nebraska with 380 individuals and 56 wagons. 

Arrived Salt Lake 15 Sep 1859 
 

 

Source: Title: Obituary – Deseret News Weekly Death Notices 1852-1888 

 Author: Compiled by Kent Davis 

 Publication Information: Compact Disk Call Number:  CD No. 1899   

 Repository: Family History Library   US/CAN LibAtt Win 

  35 North West Temple 

  Salt Lake City, Utah 84150-3400 

 

Citation: Obituary published July 17, 1882 
 

 

Source: Title: Personal Knowledge – Sally Petersen 

 Author: Peterson, Sally 

 Repository: Sally Petersen 

  1479 West 13th Avenue 

  San Jose, California 95101 

 

Citation: In attendance at birth of child. 
 

 

Source:      Title: Vital Records – British 

        Author:  British Government 

       Publication Information:  Certificate   

       Repository:   General Register Office 

       PO Box 2    

    Southport at Merseyside 

       PR8 2JD 

Comments:  Birth, Marriage and Death Index 1837-1983 Database online - 

FreeBMD.Rootsweb.com   

 

Citation:     Vol 9d, Page 295 -  1 Jul 1858  -  Sculcoates, Hull, Yorkshire, England 
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Source:      Title: Vital Records – Idaho, Western United States 

       Author: Compiled by Family History Center 

       Publication Information:   Online Database Call Number:  abish.byui.edu/SpecialCollections 

       Repository:  BYU-Idaho Family History Center 

     224D McKay Library 

     525 South Center 

     Rexburg, Idaho  83460-0405 

       Comments:  Cemetery and Burials databases, Marriage Records 

 

Citation:     #106281, Teton-Newdale Cemetery.   Alice died of pneumonia.  

 

 

Source: Title:  Vital Records – Utah State  

 Author: Compiled by Utah State Historical Society and Archives and Records Service 

 Publication Information:  Online Database  Call Number:  uhrc.utah.gov 

 Repository: Utah History Research Center 

  300 South Rio Grande Street 

  Salt Lake City, Utah 84101-1182 

Comments:  Cemetery and Burial Indexes, Death Indexes, Death Certificates, and Images, and 

other historical records  

 

Citation: Grave Location:  Logan City Cemetery, plot B_50_36_8 

 

 


